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Restore SAP HANA Databases

Restore workflow

The restore and recovery workflow includes planning, performing the restore operations,

and monitoring the operations.

The following workflow shows the sequence in which you must perform the restore operation:

You can also use PowerShell cmdlets manually or in scripts to perform backup, restore, and clone operations.

The SnapCenter cmdlet help and the cmdlet reference information contain detailed information about

PowerShell cmdlets.

SnapCenter Software Cmdlet Reference Guide.

Restore and recover a manually added resource backup

You can use SnapCenter to restore and recover data from one or more backups.

Before you begin

• You must have backed up the resource or resource groups.

• You must have canceled any backup operation that is currently in progress for the resource or resource

group that you want to restore.

• For pre restore, post restore, mount, and unmount commands, you should check if the commands exist in

the command list available on the plug-in host from the following paths:

◦ Default location on the Windows host: C:\Program Files\NetApp\SnapCenter\Snapcenter Plug-in

Creator\etc\allowed_commands.config

◦ Default location on the Linux host: /opt/NetApp/snapcenter/scc/etc/allowed_commands.config

If the commands do not exist in the command list, then the operation will fail.

About this task

• File-based backup copies cannot be restored from SnapCenter.

• After upgrading to SnapCenter 4.3, the backups taken in SnapCenter 4.2 can be restored but cannot be

recovered. You must use HANA studio or HANA recovery scripts external to SnapCenter to recover the

backups taken in SnapCenter 4.2.
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• For ONTAP 9.12.1 and below version, the clones created from the SnapLock Vault Snapshots as part of

restore will inherit the SnapLock Vault expiry time. Storage admin should manually cleanup the clones post

the SnapLock expiry time.

• For SnapMirror active sync restore operation, you must select the backup from the primary location.
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SnapCenter UI

Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, filter resources from the View drop-down list based on resource type.

The resources are displayed along with type, host, associated resource groups and policies, and

status.

Although a backup might be for a resource group, when you restore, you must select

the individual resources you want to restore.

If the resource is not protected, “Not protected” is displayed in the Overall Status column. This can

mean either that the resource is not protected, or that the resource was backed up by a different user.

3. Select the resource, or select a resource group and then select a resource in that group.

The resource topology page is displayed.

4. From the Manage Copies view, select Backups either from the primary or secondary (mirrored or

vaulted) storage systems.

5.
In the Primary backup(s) table, select the backup that you want to restore from, and then click .

6. In the Restore Scope page, select either Complete Resource or File Level.

a. If you select Complete Resource, all of the configured data volumes of the SAP HANA database

are restored.

If the resource contains volumes or qtrees, the Snapshots taken after the Snapshot selected for

restore on such volumes or qtrees are deleted and cannot be recovered. Also, if any other

resource is hosted on same volumes or qtrees, then that resource is also deleted.

b. If you select File Level, then you can either select All or select the specific volumes or qtrees,

and then enter the path related to those volumes or qtrees, separated by commas

▪ You can select multiple volumes and qtrees.

▪ If the resource type is LUN, the entire LUN is restored.

You can select multiple LUNs.

If you select All, all the files on the volumes, qtrees, or LUNs are restored.

7. In the Pre ops page, enter pre restore and unmount commands to run before performing a restore job.
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Unmount commands are not available for auto discovered resources.

8. In the Post ops page, enter mount and post restore commands to run after performing a restore job.

Mount commands are not available for auto discovered resources.

9. In the Notification page, from the Email preference drop-down list, select the scenarios in which you

want to send the emails.

You must also specify the sender and receiver email addresses and the subject of the email. SMTP

must also be configured on the Settings > Global Settings page.

10. Review the summary, and then click Finish.

11. Monitor the operation progress by clicking Monitor > Jobs.

PowerShell cmdlets

Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-

SmConnection cmdlet.

PS C:\> Open-Smconnection

2. Retrieve the information about the one or more backups that you want to restore by using the Get-

SmBackup and Get-SmBackupReport cmdlets.

This example displays information about all available backups:

PS C:\> Get-SmBackup

BackupId                      BackupName

BackupTime                    BackupType

--------                      ----------

----------                    ----------

  1               Payroll Dataset_vise-f6_08... 8/4/2015    11:02:32

AM                 Full Backup

  2               Payroll Dataset_vise-f6_08... 8/4/2015    11:23:17

AM

This example displays detailed information about the backup from January 29th 2015 to February 3rd,

2015:
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PS C:\> Get-SmBackupReport -FromDateTime "1/29/2015" -ToDateTime

"2/3/2015"

   SmBackupId           : 113

   SmJobId              : 2032

   StartDateTime        : 2/2/2015 6:57:03 AM

   EndDateTime          : 2/2/2015 6:57:11 AM

   Duration             : 00:00:07.3060000

   CreatedDateTime      : 2/2/2015 6:57:23 AM

   Status               : Completed

   ProtectionGroupName  : Clone

   SmProtectionGroupId  : 34

   PolicyName           : Vault

   SmPolicyId           : 18

   BackupName           : Clone_SCSPR0019366001_02-02-2015_06.57.08

   VerificationStatus   : NotVerified

   SmBackupId           : 114

   SmJobId              : 2183

   StartDateTime        : 2/2/2015 1:02:41 PM

   EndDateTime          : 2/2/2015 1:02:38 PM

   Duration             : -00:00:03.2300000

   CreatedDateTime      : 2/2/2015 1:02:53 PM

   Status               : Completed

   ProtectionGroupName  : Clone

   SmProtectionGroupId  : 34

   PolicyName           : Vault

   SmPolicyId           : 18

   BackupName           : Clone_SCSPR0019366001_02-02-2015_13.02.45

   VerificationStatus   : NotVerified

3. Restore data from the backup by using the Restore-SmBackup cmdlet.
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Restore-SmBackup -PluginCode 'DummyPlugin' -AppObjectId

'scc54.sccore.test.com\DummyPlugin\NTP\DB1' -BackupId 269

-Confirm:$false

output:

Name                : Restore

'scc54.sccore.test.com\DummyPlugin\NTP\DB1'

Id                  : 2368

StartTime           : 10/4/2016 11:22:02 PM

EndTime             :

IsCancellable       : False

IsRestartable       : False

IsCompleted         : False

IsVisible           : True

IsScheduled         : False

PercentageCompleted : 0

Description         :

Status              : Queued

Owner               :

Error               :

Priority            : None

Tasks               : {}

ParentJobID         : 0

EventId             : 0

JobTypeId           :

ApisJobKey          :

ObjectId            : 0

PluginCode          : NONE

PluginName          :

The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter

Software Cmdlet Reference Guide.

Restore and recover an auto discovered database backup

You can use SnapCenter to restore and recover data from one or more backups.

Before you begin

• You must have backed up the resource or resource groups.

• You must have canceled any backup operation that is currently in progress for the resource or resource

group that you want to restore.

• For pre restore, post restore, mount, and unmount commands, you should check if the commands exist in

the command list available on the plug-in host from the following paths:

◦ Default location on the Windows host: C:\Program Files\NetApp\SnapCenter\Snapcenter Plug-in
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Creator\etc\allowed_commands.config

◦ Default location on the Linux host: /opt/NetApp/snapcenter/scc/etc/allowed_commands.config

If the commands do not exist in the command list, then the operation will fail.

About this task

• File-based backup copies cannot be restored from SnapCenter.

• After upgrading to SnapCenter 4.3, the backups taken in SnapCenter 4.2 can be restored but cannot be

recovered. You must use HANA studio or HANA recovery scripts external to SnapCenter to recover the

backups taken in SnapCenter 4.2.

• For ONTAP 9.12.1 and earlier versions, the clones created from the SnapLock Vault Snapshots as part of

restore will inherit the SnapLock Vault expiry time. Storage admin should manually cleanup the clones post

the SnapLock expiry time.

• For SnapMirror active sync restore operation, you must select the backup from the primary location.

Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, filter resources from the View drop-down list based on resource type.

The resources are displayed along with type, host, associated resource groups and policies, and status.

Although a backup might be for a resource group, when you restore, you must select the

individual resources you want to restore.

If the resource is not protected, “Not protected” is displayed in the Overall Status column. This can mean

either that the resource is not protected, or that the resource was backed up by a different user.

3. Select the resource, or select a resource group and then select a resource in that group.

The resource topology page is displayed.

4. From the Manage Copies view, select Backups either from the primary or secondary (mirrored or vaulted)

storage systems.

5.
In the Primary backup(s) table, select the backup that you want to restore from, and then click .

6. In the Restore Scope page, select Complete Resource to restore the configured data volumes of the SAP

HANA database.

You can select either Complete Resource (with or without Volume Revert), or Tenant

Database.
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Recovery operation is not supported by SnapCenter Server for multiple tenants when user selects either

the Tenant Database or Complete Restore option. You must use HANA studio or HANA python script to

perform the recovery operation.

a. Select Volume Revert if you want to restore the entire volume.

This option is available for backups taken in SnapCenter 4.3 in NFS environments.

If the resource contains volumes or qtrees, the Snapshots taken after the Snapshot selected for restore

on such volumes or qtrees are deleted and cannot be recovered. Also, if any other resource is hosted

on the same volumes or qtrees, then that resource is also deleted. This is applicable when Complete

Resource with Volume Revert option is selected for restore.

b. Select Tenant Database.

This option is available only for MDC resources.

Ensure to stop the tenant database before performing the restore operation.

If you select Tenant Database option, you must use HANA studio or use HANA recovery scripts

external to SnapCenter to perform recovery operation.

7. In the Recovery scope page, select one of the following options:

If you… Do this…

Want to recover as close as possible to the current

time

Select Recover to most recent state. For single

container resources specify one or more log and

catalog backup locations.

For multitenant database container (MDC)

resources specify one or more log backup locations

and the backup catalog location.

For MDC resources, the path should contain both

system database and tenant database logs.
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If you… Do this…

Want to recover to the specified point in time Select Recover to point in time.

a. Select the time zone.

Browser timezone is populated by default.

The selected time zone along with the input time

is converted to absolute GMT.

b. Enter date and time. For example, the HANA

Linux host is located in Sunnyvale, CA and the

user in Raleigh, NC is recovering the logs in to

SnapCenter.

The time difference between both these

locations is 3 hours, and since the user has

logged in from Raleigh, NC, the default browser

time zone that will be selected in the GUI is

GMT-04:00.

If the user wants to perform a recovery to 5 a.m

.Sunnyvale, CA, then the user has to set the

browser time zone to the HANA Linux host time

zone, which is GMT-07:00 and specify the date

and time as 5:00 a.m.

For single container resources specify one or

more log and catalog backup locations.

For MDC resources, specify one or more log

backup locations and the backup catalog

location.

For MDC resources, the path should contain

both system database and tenant database

logs.

Want to recover to a specific data backup Select Recover to specified data backup.

Do not want to recover Select No recovery. You must perform the recovery

operation manually from the HANA studio.

You can recover only those backups that are taken after upgrading to SnapCenter 4.3, provided both the

host and the plug-in are upgraded to SnapCenter 4.3, and the backups selected for restore are taken after

the resource is converted or discovered as auto discovered resource.

8. In the Pre ops page, enter pre restore and unmount commands to run before performing a restore job.

Unmount commands are not available for auto discovered resources.

9. In the Post ops page, enter mount and post restore commands to run after performing a restore job.

9



Mount commands are not available for auto discovered resources.

10. In the Notification page, from the Email preference drop-down list, select the scenarios in which you want

to send the emails.

You must also specify the sender and receiver email addresses and the subject of the email. SMTP must

also be configured on the Settings > Global Settings page.

11. Review the summary, and then click Finish.

12. Monitor the operation progress by clicking Monitor > Jobs.

Restore resources using PowerShell cmdlets

Restoring a resource backup includes initiating a connection session with the SnapCenter

Server, listing the backups and retrieving backup information, and restoring a backup.

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-

SmConnection cmdlet.

PS C:\> Open-Smconnection

2. Retrieve the information about the one or more backups that you want to restore by using the Get-

SmBackup and Get-SmBackupReport cmdlets.

This example displays information about all available backups:

PS C:\> Get-SmBackup

BackupId                      BackupName                    BackupTime

BackupType

--------                      ----------                    ----------

----------

  1               Payroll Dataset_vise-f6_08... 8/4/2015    11:02:32 AM

Full Backup

  2               Payroll Dataset_vise-f6_08... 8/4/2015    11:23:17 AM

This example displays detailed information about the backup from January 29th 2015 to February 3rd,

2015:
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PS C:\> Get-SmBackupReport -FromDateTime "1/29/2015" -ToDateTime

"2/3/2015"

   SmBackupId           : 113

   SmJobId              : 2032

   StartDateTime        : 2/2/2015 6:57:03 AM

   EndDateTime          : 2/2/2015 6:57:11 AM

   Duration             : 00:00:07.3060000

   CreatedDateTime      : 2/2/2015 6:57:23 AM

   Status               : Completed

   ProtectionGroupName  : Clone

   SmProtectionGroupId  : 34

   PolicyName           : Vault

   SmPolicyId           : 18

   BackupName           : Clone_SCSPR0019366001_02-02-2015_06.57.08

   VerificationStatus   : NotVerified

   SmBackupId           : 114

   SmJobId              : 2183

   StartDateTime        : 2/2/2015 1:02:41 PM

   EndDateTime          : 2/2/2015 1:02:38 PM

   Duration             : -00:00:03.2300000

   CreatedDateTime      : 2/2/2015 1:02:53 PM

   Status               : Completed

   ProtectionGroupName  : Clone

   SmProtectionGroupId  : 34

   PolicyName           : Vault

   SmPolicyId           : 18

   BackupName           : Clone_SCSPR0019366001_02-02-2015_13.02.45

   VerificationStatus   : NotVerified

3. Restore data from the backup by using the Restore-SmBackup cmdlet.
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Restore-SmBackup -PluginCode 'DummyPlugin' -AppObjectId

'scc54.sccore.test.com\DummyPlugin\NTP\DB1' -BackupId 269

-Confirm:$false

output:

Name                : Restore

'scc54.sccore.test.com\DummyPlugin\NTP\DB1'

Id                  : 2368

StartTime           : 10/4/2016 11:22:02 PM

EndTime             :

IsCancellable       : False

IsRestartable       : False

IsCompleted         : False

IsVisible           : True

IsScheduled         : False

PercentageCompleted : 0

Description         :

Status              : Queued

Owner               :

Error               :

Priority            : None

Tasks               : {}

ParentJobID         : 0

EventId             : 0

JobTypeId           :

ApisJobKey          :

ObjectId            : 0

PluginCode          : NONE

PluginName          :

The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software

Cmdlet Reference Guide.

Monitor SAP HANA databases restore operations

You can monitor the progress of different SnapCenter restore operations by using the

Jobs page. You might want to check the progress of an operation to determine when it is

complete or if there is an issue.

About this task

Post-restore states describe the conditions of the resource after a restore operation and any further restore

actions that you can take.

The following icons appear on the Jobs page, and indicate the state of the operation:

•
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 In progress

•  Completed successfully

•  Failed

•
 Completed with warnings or could not start due to warnings

•  Queued

•  Canceled

Steps

1. In the left navigation pane, click Monitor.

2. In the Monitor page, click Jobs.

3. In the Jobs page, perform the following steps:

a. Click  to filter the list so that only restore operations are listed.

b. Specify the start and end dates.

c. From the Type drop-down list, select Restore.

d. From the Status drop-down list, select the restore status.

e. Click Apply to view the operations that have been completed successfully.

4. Select the restore job, and then click Details to view the job details.

5. In the Job Details page, click View logs.

The View logs button displays the detailed logs for the selected operation.
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